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Introduction 

It’s now over 10 years since pdfDocs was first released to the market.  During that time, over 400,000 people in 

23 countries have relied on this software for creating and working with their documents, becoming an essential 

tool in their daily work.   

pdfDocs version 4 again revolutionizes the productivity gains you can achieve, with an entirely new user 

interface, significant performance improvements and feature enhancements.  In fact, over 80% of the software 

code in pdfDocs 4 is brand new – from the editor and the user interface, to PDF creation methods - all are newly 

created technology using the very latest software development tools and methodologies. 

pdfDocs now also implements an entirely new user interface, following the familiar Office 2010/2013 style of 

ribbons and functions.  This same design has been implemented across the entire DocsCorp range of products.   

This aims to reduce training costs for your organization, and enable users of the software to be achieving great 

results from the moment they start using the software. 

pdfDocs remains the only PDF application globally that lets you work in three different modes: 

 Creating or editing a single PDF document as your default PDF viewing and editing application; 

 Editing and manipulating multiple PDF documents in the Organizer – no other PDF application allows 

you to edit multiple PDFs in a group,  re-organizing,  re-arranging,  and modifying multiple PDF 

documents for a project or matter; 

 Combining multiple documents, both PDF and non-PDF into a PDF Binder, complete with an 

automatically generated, customizable, and printable table of contents.  No other PDF application 

provides this functionality. 

Please take a moment to read this manual so that you can take advantage of many of the time saving features 

provided in the software. 

Of course, we are seeking to continually improve the software, so we welcome your suggestions.   Whilst 

DocsCorp engineers have put in years of work into this product, we know there are always additional options 

and features you would like in the software so please let us know how we can make the product even better. 

You will find detailed information on methods of installing pdfDocs covering the many different computer 

environments you may have on the DocsCorp web site, www.docscorp.com.  Simply log on to the DocsCorp 

Resource Centre.  

We welcome you to the pdfDocs ‘family’ and trust you will enjoy using this software 

Yours sincerely,  

 

 

Dean Sappey 

President - DocsCorp  

http://www.docscorp.com/
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What are the key features in pdfDocs 4 

The following features and enhancements are available in pdfDocs. 

Single Document Mode 

 Set pdfDocs 4 as the default PDF viewer 

 Launch and view PDF documents in a single instance of pdfDocs 

 Review; markup, edit from within this single instance and save changes back to disk or to your document 

management system 

 Send a PDF to an Organizer Project or Binder Project 

 Fill interactive forms 

Organizer Projects 

 Multiple Organizer Projects 

 Multiple Binder Projects 

 Organizer Project Templates 

 Set Output Options Watermarks; Stationery Set; Numbering Set; Security; Bookmarks 

 Split on output 

 Fill interactive forms 

 Optimize PDF 

Binder Projects 

 Import documents from disk or document management systems 

 Set Output Options Watermarks; Numbering Set; Security 

 Creation of customizable Table of Contents on binder production 

Redaction 

 Search; Mark Area or Mark Page(s) 

 Review prior to applying marked selections 

 Redaction tags and Overlay Text 
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DMS integration  

 Integrations offered with pdfDocs 4 include 

o Generic Automation 

o HP TRIM 

o HP WorkSite 9 

o Leap 

o Lawdocs 

o Lexis Nexis 

o MYOB DM Manager 

o NetDocuments 

o OpenText eDocs DM5 

o OpenText Content Server 

o Other Executable (Allowing for integration with a practice management system) 

o Other Directory 

o Prolaw 

o Reckon APS 

o Reckon Elite 

o Sage Handisoft 

o Microsoft SharePoint 

o Virtual Cabinet 

o VisualFiles 

o Worldox GX3 

o Further integrations will be phased in over the next months. 

 For an up to date list of integrations, please refer to the Integration Matrix available 

through the download page on the DocsCorp Resource Portal. 

 

OCR functions 

 Perform OCR actions on the desktop or on the server 

 OCR at document level in Binder Project 

 OCR document in place 
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Microsoft® Office integration 

 Add-ins for Microsoft® Word; Excel and PowerPoint 

 Create PDF; Send document to project; Convert to PDF & email or save in to document management system 

PDF/A 

 Create PDF/A-1b and PDF/A-1a documents 

 Verify PDF/A-1b and PDF/A-1a Compliance  

 ISO 19005-1:2005 compliance  
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Learning the basics 

What is pdfDocs? 

pdfDocs facilitates the creation of PDF documents from any software application and/or scanner. A DocsCorp 

PDF Printer is installed on your workstation, just as a normal printer would be installed, when you install the 

application.  Under your ‘Devices & Printers’ window, you will see a DocsCorp PDF Printer installed. 

 

This one PDF printer is shared by all DocsCorp applications, pdfDocs; compareDocs and cleanDocs. 

When you choose DocsCorp PDF Printer as your printer, any output is converted to PDF rather than printed to 

paper.  As long as your software can print to a Windows printer, pdfDocs will accept the report being printed.    

pdfDocs modes 

pdfDocs has a number of modes for viewing and working with PDF documents, they are Single document; 

Organizer Project and Binder Project.  

Single Document 

This is the ability to open and view a PDF document. Once open in pdfDocs, the document can be marked up, 

edited, redacted (for example), closed and saved back to disk or saved to a document management system. 

To open a PDF in pdfDocs, double click on a PDF, the selected document will be opened in pdfDocs (this is 

assuming that pdfDocs has been set as your default PDF viewer). Refer to page 11 on how to set pdfDocs as your 

default PDF viewer. 

 

 

Tip: 

Set pdfDocs as default PDF viewer 

pdfDocs can be used as the default PDF viewer, open pdfDocs, go to File > Options > General 

> Import and Open Options, and click on ‘Make default viewer and editor’.  
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Alternatively, follow these steps (note that these steps may vary slightly for different 

operating systems, the steps below are for Windows 8) 

1. Right click on a PDF and select Open With; 
2. Select ‘Choose default program’; 
3. Check the option for ‘Use this app for all .pdf files’ 
4. Select pdfDocs from the list of compatible applications; 
5. pdfDocs 4 will now be set as the default PDF viewer; 
6. If at step 4 pdfDocs does not show in the list of compatible 

apps, select ‘More Options’; 
7. Scroll down and select ‘Look for another app on this PC’; 
8. Browse to C:\program files (x86)\DocsCorp\pdfDocs; 
9. Double click on pdfDocs.exe; 
10. pdfDocs will now be set as the default PDF viewer. 

 

Organizer Project 

An Organizer Project is a collection of PDF documents, any document printed to, imported or dropped in to an 

organizer project is converted to PDF. This collection of documents can be worked on individually or as a 

collection of documents for output. An organizer project provides an efficient method to work on related 

documents relevant to a single piece of work.  

Organizer Projects allow for the import of multiple documents in to a single project. From here, documents 

within the project can be marked up and collated in to a single document when exported or saved from the 

project.  

An Organizer Project will present a list of documents in the Navigation pane. To add documents, drag and drop a 

document to the document list, or select the Import button from the Home ribbon. 

An Organizer Project is a self-contained file stored on disk. They have a file extension of *.pop (pdfDocs 

Organizer Project). Organizer Projects will appear in the most recently used list in the pdfDocs backstage view. 

Multiple Organizer Projects can be opened at the same time, with each project appearing in its own instance of 

pdfDocs. Documents outputted from an organizer project can be collated in to a single PDF, or outputted as 

individual documents. Organizer Projects provide for options to add Watermarks; Stationery Sets; Numbering 

Sets; Security and to work on Bookmarks and set initial view settings. 

Binder Project 

A Binder Project is a collection of documents which can be of type PDF, or can be kept in their native file format.  

A Binder Project provides an efficient method to work on documents which relate to a single piece of work.  

Documents outputted from an organizer project can be collated in to a Single PDF Binder, or outputted as 

Multiple PDF Binder. Binder Projects provide for options to add Watermarks; Numbering Sets; Security and set 

initial view settings. 

On binder production, a fully customizable table of contents is automatically created. 
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Starting pdfDocs 

 pdfDocs is started by any of the following methods: 

 Choosing the pdfDocs printer as the target printer to print a document or output.  

 Double-click on the pdfDocs icon  in the ‘system tray’ (bottom right corner of your screen);  

 Go to  Start menu and select the pdfDocs application  

  

 Use pdfDocs shortcut on the Desktop; 

 Place certain suitable document types* into a WatchFolder configured in pdfDocs; 

 Drag & Drop certain document types* onto the pdfDocs shortcut on the Desktop; 

 Use right-click menu options in certain integration Document Management Systems (DMS); 

 Click on the pdfDocs toolbar heading in Microsoft® Word, Excel or PowerPoint; 

 Click on the pdfDocs icon that shows in the toolbar of Microsoft® Outlook. 

 

 

 

*Document types that can be imported directly using WatchFolders or drag & drop 

include PDF, graphic file types such as TIF, JPG, BMP and Microsoft® Office document 

types including DOC(X), XLS(X) and PPT(X). Please refer to full list on page 82. 

 

How best to use pdfDocs to suit your needs 

Because pdfDocs offers such flexibility on how to view and work with PDF documents, setting initial default 

behavior when first launching pdfDocs, will assist in a number of workflows. 

Open PDF 

The most common need of pdfDocs is to simply open and view a PDF. By setting pdfDocs as your default PDF 

viewer, you will be able to double click on a PDF on disk or from a mail message in the form of an attachment. 

Refer to page 11 on how to set pdfDocs as your default PDF viewer. 
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Convert to PDF 

There are times that you may wish to convert a document to PDF. From any application, as long as the software 

can print to a Windows printer, pdfDocs will accept the document being printed. From your application, select 

the DocsCorp PDF Printer to print to and convert to PDF. 

Alternatively, if you are working in Microsoft Office applications Word; Excel or PowerPoint, you can access the 

DocsCorp ribbon, from which you can select one of four options. 

 

 

 Open in pdfDocs 

o The document will be opened in pdfDocs as a temporary PDF. The PDF can then be saved. 

 Import into Project 

o The document will be converted to PDF and sent to an Organizer Project. Refer to page 14 on how 

to select a default Organizer Project. 

 Email as PDF 

o The document will be converted to PDF and attached to a new draft email 

 Save as PDF 

o The document will be converted to PDF and opened in pdfDocs. You will be presented with the 

backstage view in pdfDocs from which you can choose a location to save 

 Save into DMS 

o Allows for the conversion to PDF and saving into a document management system 

 

When selecting to ‘Import into Project’, there are options available to you in order to set default workflows. 

You will need to access the Options window in the backstage view. Open pdfDocs and select File > Options > 

General 

For further information on these settings, please refer to File Options > General section on page 37. 
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Backstage View 

The backstage view (BSV) provides for easy access to all task based workflows such as Save; Save As or Print for 

example.  

All output actions on a document will guide you to the backstage view in pdfDocs.  

 

 

From the pdfDocs 4 backstage view there are options for New; Open; Save; Save As; Import; Export; Print and 

Share.  

 

New 

Select New from existing to browse to a compatible document to be converted to PDF. The converted document 

will be opened in a single instance of pdfDocs. 

Select New Organizer Project or New Binder Project to create a new project on disk to which documents can be 

added for markup and collation. 

 

Open 

Select a document or project from the most recently used list to launch in to pdfDocs, or choose Computer to 

browse to a compatible document on disk to open or convert to PDF. 
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Save As 

From the Save As menu, user output options can be set on the fly, page range selected, alternate document type 

chosen. Split options are also available from the Save As menu.  

Organizer Projects and Binder Projects can be saved to alternate locations (i.e. a template location), or saved 

with a new project name. 

 

Import 

Import is only active whilst in an Organizer Project. From the Import menu, documents can be added to the 

active project from the most recently used document list, or browse to a location on disk to select documents to 

import to the Organizer Project. Selection of a none-PDF document for importing will be converted to PDF prior 

to importing to the Organizer Project. 

 

Export 

Select File > Export, to send selected documents to another project. Alternatively documents can be exported 

and converted to Word; Excel; TXT or Image formats. 

Options to export to PDF/A-1a and PDF/A-1b formats are also available from the export menu. Documents will 

be validated automatically as part of the export process, to ensure that they meet compliance for PDF/A format. 

Print 

Select File > Print, or Ctl + P to open the print preview window in the pdfDocs 4 backstage view. To browse 

through the pages, select advance arrows to navigate through the print preview window, or type in a page 

number to jump to a particular page. 

Select the expand icon to show Output options. These can be selected and applied to the printed document 

such as Stationery, Header & Footer (Numbering Set) and Watermarks. Other output options Bookmarks; PDF 

Properties; Digital Signatures; Security and Initial View although enabled, will not apply for print workflows. 

These will be greyed out for the full production release. 

To print only certain pages, select from the page range drop down menu or type in a custom page range. 

If you are printing a document that has Stamps and/or markups, select from the document markup drop down 

on which view you would like printed. 

Additional options are available from the Printer Properties menu. 

To return back to the document, select the Back arrow  
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Share 

If you have Microsoft Outlook installed, you can send a document as an attachment to an email by selecting 

Share from the file menu. You can rename the attachment name and apply output options to the document 

prior to sending.  

Selecting the Send as Attachment icon will open a new email message with the selected document attached. 

Enter in your recipient’s details and Send. 

 

Close 

Close the currently open PDF or project, with a prompt to Save if any edits have been made since last save. 

 

About 

Refer to the Help section on page 83 for further information 

 

Options 

Refer to the Options section on page 37 for further information 
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Organizer 

Overview 

Organizer Projects allow for the import of multiple documents in to a single project. From here, documents 

within the project can be marked up and collated in to a single document when exported or saved from the 

project.  

An Organizer Project will present a list of documents in the Navigation pane. To add documents, drag and drop a 

document to the document list, or select the Import button from the Home ribbon. 

 

An Organizer Project is a self-contained file stored on disk. They have a file extension of *.pop (pdfDocs 

Organizer Project). Organizer Projects will appear in the most recently used list in the pdfDocs backstage view. 

Multiple Organizer Projects can be opened at the same time, with each project appearing in its own instance of 

pdfDocs 4.  

A document that is showing in the Organizer is already a PDF.  Even if you are importing a document of another 

format, such as a Microsoft® Word document, once it appears in the Organizer it is already in PDF format. 

The ‘Organizer list’ displays a list of documents currently available. These documents have been, at some stage, 

printed to, scanned or imported into pdfDocs.  Documents will remain in the list, and will remember their 

‘checkbox’ status even if you restart your computer. 
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Ribbons 

pdfDocs has seen the introduction of ribbons with the same look and feel as Microsoft Office 2010 / 2013. All of 

the functions required for saving, marking up, editing, redaction or display options for example are now 

contained within the ribbons. 

There are subtle differences in ribbon behavior between a PDF viewed in a single instance of pdfDocs, to that 

seen in an Organizer Project. 

Working with ribbons between a single PDF or within an Organizer Project do follow the same logic though, 

common workflows such as saving; annotating; drawing and zoom controls are on the Home ribbon.  

Controls for reviewing a document are on the Review ribbon, including expanded annotate controls; drawing 

and compare for those with compareDocs installed. 

Edit ribbon allows for content editing, including text edit, inserting images, page control, OCR and optimization 

functions. 

Redaction controls all fall under the Protect ribbon, with the last ribbon being View which controls how the 

application presents documents and panes within the application. 

How do I apply Output Options to documents 

Output Options are markup that is applied to documents, this markup can be Watermarks; Header & Footer or 

Stationery. 

When viewing a PDF in single document mode, these options are enabled from the Edit ribbon and are applied 

in place as soon as your selection is made, i.e. what you see is what you get. For example, I wish to apply a 

Watermark to a PDF 

 

1. Open a PDF 

2. Select the Edit ribbon 

3. Click on Apply Watermark 

4. From my drop down select from a predefined Watermark 

5. Selected Watermark is applied to the document 

 

If you are working in an Organizer Project, by selecting Watermark; Header & Footer or Stationery information 

from the Home ribbon marks your intent to apply at time of saving a document or collection of documents, i.e. 

the information does not show immediately on documents in the project, but will be applied when the 

documents are saved out of the project. For example, I wish to apply my firms’ stationery to documents that I 

output from the project 
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1. Open an Organizer Project 

2. Select the Home ribbon 

3. Select the Stationery drop down 

4. Select a stationery set 

5. Stationery icon is now highlighted reflecting that this option is now enabled 

6. If I output a document from the project (i.e. my selected stationery is now applied to the document) 

7. I can easily toggle the Stationery on and off by clicking on the Stationer icon on the Home ribbon 

 

If you wish to apply in place Watermark; Header & Footer or Stationery information to documents in an 

Organizer Project, this is possible. For example, I wish to add Numbering to documents in an Organizer Project 

 

1. Open an Organizer Project 

2. Select the Edit ribbon 

3. Select the drop down on Apply Header & Footer 

4. Select a Numbering Set 

5. The selected numbering is now applied in place to the documents in the project, before they are 

outputted from the project 

 

How do I markup a PDF 

When viewing a PDF in a single instance or working in an Organizer Project, all functions for markup appear in 

the Annotate group on the Home ribbon, with these functions repeated on the Review ribbon plus additional 

annotate functions. 

There may be repetitive annotations or stamps that you wish to add to a document, in this situation, right click 

on an annotation and select ‘Keep tool selected’. Selecting this function will then remain in focus until you press 

your Esc key, or select another annotation. For example, I wish to highlight multiple lines on a page 

 

1. Select the Home ribbon 

2. Right click on Highlight 

3. Select ‘Keep highlight tool selected’ 

4. Move your cursor to your text that you wish to highlight 

5. Click and mark text 

6. Continue highlighting text as you move down the page or move to the next page 
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How do I add an image to a page 

1. Select the ‘Add Image’ icon from the Home or Edit ribbon 

2. A Windows Explorer window is presented 

3. Browse through to required image 

4. Once image is selected draw image on to page 

5. The image can be resized from the anchor points or rotated 

6. Click away from image to finish 

7. To edit the image or move, select the Edit Image icon from the Edit ribbon 

8. Click on image 

9. Drag to move, select anchor points to resize or select Delete key to remove image 

 

How do I send a PDF to another project 

There will be times where you will want to send a PDF to a project so that the PDF can be combined with a 

collection of PDF’s, for example, your receive an email with a PDF attachment which you need to view and send 

to a working project 

1. Double click the PDF attachment; 
2. The PDF opens in a single instance of pdfDocs (if pdfDocs is set as the default PDF viewer); 
3. View the document, mark it up etc.; 
4. From my Home ribbon, I click Send to Project icon; 
5. This will take me to my backstage view, Export menu from which I can select from a pinned project in 

my most recently used list (MRU), or browse to another project; 
6. Alternatively, at step 4, I could select the drop down menu on my Send to Project icon; 
7. The drop down list will show currently open projects, separated by projects which are pinned as 

favorites (the pinned list is read from my MRU list); 

 

 
 

8. Once a project has been selected, the document will be sent to the project; 
9. If the project selected is currently closed, the project will be opened. 

The same workflow can be achieved whilst working inside an Organizer Project. A document, or a collection of 

documents can be sent to another project.  

In all cases, the destination project can either be a Binder Project, or an Organizer Project. 
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How do I save a PDF 

Single Document Mode 

When viewing a PDF in a single instance of pdfDocs, all save actions are in the save group on the Home ribbon. 

For example, I receive an email with a PDF attachment, I need to view, date stamp and save my document to 

disk 

1. Double click on the PDF attachment 

2. PDF opens in a single instance of pdfDocs (assuming you have set pdfDocs as your default PDF viewer) 

3. Select the Stamps dropdown from the annotate group on the Home ribbon 

4. Go to the Dynamic menu level 

5. I select the Received stamp 

6. I click on the page to add stamp 

7. A Received stamp is added to the document date and time stamped, along with the users login name 

8. From the Save group on the Home ribbon select Computer 

9. The Save As menu is presented in the backstage view 

10. Select a folder from the most recently used list or browse to a different location 

11. Save your document 

 

Alternatively at step 8, I could select Save into DMS if you have a document management system installed. Other 

options include  

 Email – the PDF is attached to a new draft email 

 Export To – will present you with the Export menu in the backstage from which you can convert the 

document to anther file format 

 Preview – will load the document in to your default PDF viewer 

 Clipboard – will copy the document to your Office clipboard ready for pasting 

 

Organizer Project 

The key thing to remember with Organizer Projects is that a project is a self-contained collection of PDF’s. 

Working on documents in a project then closing the project will prompt you to save your changes, this save 

action is on the project which the PDF’s sit within, this will allow you to close the project and reopen at a later 

date to continue working on documents in the project, marking up or adding further documents to the project. 

At the time that you wish to export documents out of the project you would select a function from the Export 

group on the Home ribbon. For example, I have a project with twenty documents that I have been marking up, I 

have enabled a Stationery Set and Watermark from the Output Options, and I now wish to email these twenty 

documents as a single PDF, renaming the document in the process. 
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1. Select Email from the Export group on the Home ribbon  

2. You will be presented with the Share menu in the backstage 

3. My file type is *.pdf 

4. I choose Collated Document from my drop down menu 

5. I can change the attachment name 

6. The Output Options reflect that a Stationery Set and Watermark have been enabled 

7. Click on ‘Send as Attachment’ 

8. The twenty documents will be collated in to the one PDF, with Stationery and Watermark applied with 

the resultant PDF added as an attachment to a new draft email 

 

 

How do I produce a text searchable PDF 

A common need is to produce a text searchable PDF. For a PDF to be text searchable, an additional text layer 

must be included in the PDF. Most scanned documents do not have this text layer, but just an image of the text 

produced when the document is scanned. This image layer is not text searchable. 

To produce a text layer, the document has to be OCR’d. To do this in pdfDocs, select the OCR icon from the Edit 

ribbon. Current Page or All Pages can be selected. Once an options is made, the selected page(s) are OCR’d and a 

text layer is added in place to the document. 

Once the OCR process is finished, text can be searched for within the document. Select Ctrl + F hotkeys will show 

the search window on the Navigation tab. Type in the text string to search for, the search is dynamic and will 

begin to search as you type in the search criteria. The results will be displayed in the Results pane. A search in an 

Organizer Project will group the search hits by document. A search in an Organizer Project will also conduct a 

search on the document list, narrowing down the visible documents in the Document pane as the search criteria 

is typed in. 
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Binder Projects 

Overview 

A Binder Project combines multiple documents, both PDF and non-PDF into a PDF Binder, complete with an 

automatically generated, customizable, and printable table of contents.   

Binders offer the following capabilities:  

 The ability to collate PDF and non-PDF documents into a single or multi document Binder Project;  

 The ability to choose individual files or folders to be added to a Binder Project; 

 Include individual documents or folders stored in a document management system in the Binder Project; 

 Automatically generate a Table of Contents, cross-document links, bookmarks and indexes; 

o Use in-house Word templates and styles to generate the Table of Contents; 

 Assign a Cover Page from within the Binder; 

 Configure Binder Project options and settings that are unique to each Binder Project and portable with the 

Binder Project; 

 Add or remove documents from the set and regenerate the Table of Contents; and 

 Save the Binder Project to a network location. 

 

Create Binder Project 

To create a Binder Project  

Open pdfDocs 

Go to File > New > Binder 

Type in a Name for your Binder 

Select a location 

Select Create Project 
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The Binder Workspace 

 Add Item – Allows the user to add a variety of items to the current binder and displays the Add Item To 

Binder window: 

o New Folder – Adds a new folder within the open Binder Project, allowing users to specify the name 

of the newly added folder;  

o Explorer Folder – Displays a Browse For Folder window, allowing users to locate and add entire 

folders on their computer or network to the Binder Project currently open, including all documents 

residing within the Explorer Folder; 

o Explorer Folder (Inc. Sub-Folders) – Displays the Browse For Folder window above and allows the 

same functionality as adding an Explorer Folder, with the added benefit of including all Sub-Folders 

contained within the Explorer Folder selected; and 

o Explorer Document – Displays an Open window, allowing users to locate and add individual 

documents to the Binder Project from the File System (i.e. Windows Explorer). 

o Exclude saved search folders – This option will only be displayed for Autonomy iManage FileSite and 

DeskSite users. By selecting this option when importing whole folders, and sub-folders which are 

Saved Search folders will not be imported. 

 Binder Options – Refer to Binder Options on page 31. 

 Security – Enable security options to be applied to PDF’s in final binder when Make Binder is selected. 

 Watermarks – Enable watermarks to be applied to PDF’s in final binder when Make Binder is selected. 

 Numbering – Enable page numbering options to be applied to PDF’s in final binder when Make Binder is 

selected. 

 Initial View – Enable initial view options to be applied to PDF’s in final binder when Make Binder is selected. 

 Binder Type – Allows users to specify the type of Binder PDF they wish to produce, being: 

o Single PDF Binder – A single, bound PDF document, containing all Binder documents;  

o Multiple PDF Binder – A multi-document, bound PDF package consisting of all Binder documents.  

Multiple PDF Binders are most useful when file size restrictions must be adhered to; 

o Cover Page Binder – A single, bound PDF document, containing only the Table of Contents and the 

Binder’s Cover Page.   

 Make Binder – this button starts the creation of a binder and displays a number of options to the user. 

o Binder Name – Choose a name for this Binder. This allows the user to make as many Binders as they 

like. 

o Show in Explorer – Upon completion of the Binder creation process, a Windows Explorer window 

will be displayed, opening to the location of the PDF Binder; 

o Create Auto Launch for CD/DVD – Selecting this option creates an “Autorun.inf” file, which when 

copied onto a CD/DVD with the PDF Binder, will automatically launch the Binder when the CD/DVD 
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is inserted into a drive.  The “Autorun.inf” file contains the following information: 

 [autorun] 

 shellexecute="[Name of Binder Package].PDF" 

Note: please refer to the section called ‘Make Binder workflow considerations – autorun.inf’ on 

page 34 for additional information on this. 

o Save Into – ONLY available for Single PDF Binders and with integrations to document management 

system  – Allows users to check their Single PDF Binder into their document management system; 

o Show Table of Contents – Allows users to view the PDF Binder created by launching the Table of 

Contents upon completion of the Binder creation process; 

o Enable Universal File Naming – ONLY available for Multiple PDF Binders – Allows users to adopt 

Universal File Naming which eliminates the possibility of elongated and non-conforming file names. 

Each bound document is referenced using a name relative to its position in the PDF Binder     (e.g. 

000012.pdf), whilst ensuring that the PDF Binder does not exceed maximum file name lengths and 

locations in the target file system. 

If Enable Universal File Naming is unchecked, then Standard File Naming is followed, which creates 

the Multiple PDF Binder with naming adopted from the “child” documents making up the Binder 

o Embed Unconverted Files – ONLY available for Single PDF Binders – will embed unconverted files 

into the Single PDF Binder in their native file format. Documents will stay in their native format if the 

Convert to PDF checkbox is left unchecked on the document list. 

o OK - This button initiates compilation of the Binder Project and will display the Make Binder 

window. 

This window displays the various processes performed when generating the Binder as well as 

displaying progress.  

Upon completion of this process, the Binder is opened in Windows Explorer, and will contain all documents, 

either converted to PDF where possible or selected, or the source documents in their native format (i.e. those 

documents that could not be converted to PDF, or were specified by the user to not be converted when bound). 
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This Binder folder will also contain the table of contents generated, with hyperlinks and bookmarks if specified 

via the Binder Project Options. 

 Snapshot – Allows users to take a ‘Snapshot’ of a Binder Project at a particular point in time.  Once a 

Snapshot has been taken, the structure and contents of that Snapshot are effective locked, meaning that 

pdfDocs will not allow moving or deletion of existing files and folders.  If a Snapshot has been taken 

erroneously, then the same Snapshot button can be dropped-down, offering the ability to Revert All 

(returning the Binder Project to its original “un-snapshotted” state) or Revert Last (returning the Binder 

Project to its original “snapshotted” state).  At each point in the Snapshot/Revert process, users will be 

prompted to confirm any selections made with a message. 

 Customize View – Allows users to view all available columns in the current pdfDocs Binder Project.   

If additional metadata is available to pdfDocs, then this additional information may also be available for 

selection via the Binder – Customize View window.   

As well as adding columns to the Organizer interface, the Binder – Customize View window also allows you 

to specify which column will the used to sort the information presented in the Binder Project;  

Click on the ‘Add Criteria’ button, and selected required field from the drop down menu in the Field column. 

The associated Metadata and Order can be selected, and sort priority can be established by moving the 

selected Field up of down the list, by highlighting and selecting either the Up or Down arrow. 

 Switch Windows –allowing for switching to another open PDF or project. 
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Make Binder – Error Reporting 

When the Make Binder process is started, there are a number of workflows conducted. Documents are firstly 

converted to PDF (if required); Numbering Sets are then added along with Bookmarks created and finally the 

Table of Contents is produced. 

During the initial conversion to PDF, if a problematic document is 

encountered it is skipped with the process continuing to see if other 

documents can be converted to PDF. At the end of the first pass through all 

documents, the process will stop and a document count will show 

indicating how many documents have failed to convert to PDF. 

 

 

 

Clicking on OK will provide a message that will provide some 

hints on what to do to rectify issues with the problematic 

documents. 

Click OK to return to the Binder project, all problematic 

documents either need to be resolved or removed from the 

project before the binder process completes successfully. 

Once all problematic documents have been corrected, click 

on the Make Binder button, this will review all documents 

again but will not require for the conversion of documents 

to PDF that were successfully converted during the first 

pass, saving you time on the second pass. If all documents 

have been successfully converted the binder will be 

produced successfully. 

 

All problematic documents and parent folders will have warning icons to indicate issues. You have the option to 

right click at the document or folder level to clear warnings once documents have been fixed. It is not obligatory 

to clear these warnings before starting the Make Binder process again but all problematic documents do have to 

be fixed before the Make Binder process can successfully create the binder output. 
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Creating & maintaining Binder Templates 

Binder Templates are used to pre-define the structure and settings for a Binder Project that are to be re-used, 

saving time and effort in creating new Binder Projects.   

Project Templates can be created and saved to a network location. This location is established as a default 

location through an entry in the users’ pdfDocsAppSettings.xml.   

The pdfDocsAppSettings.xml is located in the client machine roaming profile directory, for example 

C:\Users\User.Name\AppData\Roaming\DocsCorp\pdfDocs\Config 

Open this file in a text editor and add the following lines to the xml file, substituting Dir_Path with your required 

location. This can be a mapped drive or unc path. 

 

<OrganizerSettings version="0" enforced="true"> 

    <DefaultOrganizerPath>Dir_Path</DefaultOrganizerPath> 

    <DefaultOrganizerTemplatePath>Dir_Path</DefaultOrganizerTemplatePath> 

    <DefaultServerOrganizerTemplatePath>Dir_Path</DefaultServerOrganizerTemplatePath> 

  </OrganizerSettings> 

  <BinderSettings version="0" enforced="true"> 

    <DefaultBinderPath>Dir_Path</DefaultBinderPath> 

    <DefaultBinderTemplatePath>Dir_Path</DefaultBinderTemplatePath> 

    <DefaultServerBinderTemplatePath>Dir_Path</DefaultServerBinderTemplatePath> 

  </BinderSettings> 

 

You only need to add those lines that you wish to set a default path for.  

This method of having a central store of Binder Templates facilitates the need for standard numbering and 

security along with other user options for the user in the form of local templates or for the whole company in 

the form of server based templates. 

Server based Binder templates can then be maintained within the one area, allowing for amendments to be 

made and applied to any new Binder created. 

Once server based templates have been created, a user who selects to create a New Binder Project can choose 
Binder Project From Template, then select Server Templates.  
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Creating and saving a project as a template 

1. Open pdfDocs 
2. Go to File > New > Binder > Binder Template 
3. Type in a Name 
4. Select a location 
5. For local templates select the location as configured against <DefaultBinderTemplatePath>  in the 

pdfDocsAppSettings.xml  
6. For server templates select the location as configured against <DefaultServerBinderTemplatePath> 

in the pdfDocsAppSettings.xml  
7. Select Create Project 
8. A new empty Binder Project will be opened 
9. Import required documents that need to always be in the project 
10. Set output options 
11. Close the project 
12. Select Yes to prompt to save changes 

 

Creating a project from a Server Template 

1. Open pdfDocs 

2. Go to File > New > Binder 

3. Select Binder Project From Template 

4. Select Local Template and browse through to your local template directory, OR 

5. Select Server Template and select project template from drop down menu 

6. Type in a name for your new project 

7. Select a location to save your new project 

8. Select Create Project 

  

 

 

New Project from the File Menu or Binder context menu, specifying Binder Templates as the Binder type.  Once 

a name and location for the Binder Template have been specified, and OK is selected, the Binder Template will 

be saved. 

The default location for Binder Project Templates is C:\...\My Documents\My Binder Templates. 

Binder Templates are particularly useful where common processes and procedures result in common packages 

of documents – e.g. International Patent applications, Family Court submissions, etc.  Binder Templates ensure 

that a standardized approach can be adopted in the creation of Binder Projects, and therefore consistency 

across all bound PDF documents. 
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Creating Binder Projects from Binder Templates 

Binder Projects can be created based on existing Binder Templates. Creating Binder Projects from Binder 

Templates is begun by selecting New Project from the File menu.  

When New Project is selected, the New Project window is displayed, offering Binder Project From Template as 

an option.  Users are then required to locate the Binder Template upon which the new Binder Project will be 

based. 

The original Binder Template is not impacted by this function, maintaining integrity of the Template for others to 

use. 

Binder Templates can be stored locally (i.e. on the user’s computer) or on a Server.  Server-based Binder 

Templates are displayed in the Server Template dropdown list, allowing users to simply select the Template 

appropriate to their task. 

See Appendix B for information regarding the setting up of Server-based templates for Organizer and Binder 

Projects. 

Binder Project Options & Settings 

Binder Options are self-contained (i.e. unique and portable with the Binder Project or Binder Template) and 

independent of Organizer settings and options.  The Binder Options window is displayed and allows users to 

specify functions and behaviors upon generation of the Binder Project or Template. To display the Binder 

Options, right click on the Binder Tab and select Binder Options from the pop-up menu.  

Binder Options 

 Table of Contents – This option is selected by default and instructs pdfDocs to generate a table of contents 

upon creation of the Binder Project;  

 Table of Contents Bookmarks – This option is selected by default and instructs pdfDocs to create bookmarks 

within the bound project’s table of contents.  This will ensure that the table of contents can be used to 

navigate throughout the bound project; 

 Table of Contents Bookmarks in sub-documents – This option is selected by default and instructs pdfDocs to 

create bookmarks to sub-documents within the Binder Project table of contents.  This will ensure that the 

table of contents can be used to navigate throughout the entire Binder Project, including all documents 

within folders and sub-folders; 

 Template Name and Location – Template Name and Location allows you to configure the name of the Table 

of Contents when referred to in the Bookmarks or Table of Contents, and the location of the Table of 

Contents template used when generating the Binder.  This field also allows users to specify the location of 

an alternate table of contents template (e.g. a branded table of contents template with company logos, 

etc.); 
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Note:  Your Table of Contents template for Binder Projects can be edited and configured to your liking.  See 

Appendix A for more information on customizing your Binder Project Table of Contents. 

 ‘PDF Conversion’ Options – these optional selections allow users to specify which document types will be 

automatically converted into PDFs upon generation of the Binder Project and include the following 

document types: 

o Microsoft® Outlook Emails; 

o Microsoft® Word Documents; 

o Text documents. Graphic Files –BMP, EPS, GIF, ICO, JPG, JPEG, PNG, PS, PSD, STM, TIF, TIFF & WMF 

o Microsoft® Excel Workbooks and Worksheets; 

o Microsoft® PowerPoint Presentations; 

o Publisher Documents 

 

 File System Path Length 

o Enforce Maximum Target File System Path Length - This option allows users to specify and enforce a 

maximum path and file name combination.  For example, if a File System has a 255-character length 

for file and path name combinations, and the total character length is exceeded, then a message 

will appear in the Make Binder window.  

If a document added to a Binder Project exceeds the maximum target file system path length, an 

icon will appear as a warning. Hovering over the icon will show by how may characters the limit has 

been exceeded by. 

o Maximum Path Length of Target File system (characters) – This is the count of characters that make 

up the full path of binder location plus document and file extension 

If the count is exceeded, a warning message will be presented at time of making binder. 

 

 Relative Path Length 

o Enforce Maximum Relative Path Length – This setting takes in the whole character count from the 

root of the binder name directory. By calculating a relative path, any subfolders incorporated into 

the binder structure can be accommodated for. 

This setting is best utilized for CD/DVD burning software that has character count limits, 

commencing its count from the root of the parent directory. 

When this option is in use, pdfDocs shows a red flag on documents that exceed this limit  

If at ‘Make Binder’ time, the count exceeds the maximum permitted, a warning message will be 

displayed to the user. 

o Maximum Relative Length of Binder Files (characters) – Set this to the required relative character 

count. 
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 Embedded Files 

o Index Embedded Files – this option is only applicable to the creation of Single PDF Binders.  

When documents imported into a Binder Project are kept in their native format, they can be 

embedded into a Single PDF Binder. These documents will appear in the document pane when 

viewed in Adobe Reader. 

To allow for an efficient method to retrieve the relevant document, a document can be prefixed 

with an index number. 

o Default Adobe View – if set to Bookmarks Pane, the attachments pane will not show by default. A 

user will need to select the paper clip icon to show any embedded documents. 

 

 Processing 

o Edit Table of Contents – this option is deselected by default.  When selected, upon creation of the 

Binder Project, pdfDocs will pause the creation process at the point where the table of contents is 

being generated.  This table of contents will then be displayed in Microsoft® Word, allowing manual 

editing of the table of contents prior to conversion into PDF. 

o PDF/A Enabled – Not currently enabled for pdfDocs 4.1 

 

 Document Links 

o Open Bookmarks in new Window – the selection of this option, results in the launching of a separate 

instance of Reader for each bookmark that you select.  

o Open Hyperlinks in new Window – the selection of this option, results in the launching of a separate 
instance of Reader for each hyperlink that you select.  

 
 Please note that Document Links are only applicable to Multiple PDF Binder Projects. 
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Make Binder workflow considerations – autorun.inf 

Upon binder production, the user has the choice on whether to produce a Single PDF Binder or a Multiple PDF 

Binder, combining these two options with various check status of Table of Content options under Binder 

Options, will have an impact on contents within the autorun.inf. 

Single PDF Binder – Because the final output is a single document, this document will be named based on the 

Binder Name entered at ‘Make Binder’.  

This information will also be entered in to the autorun.inf 

[autorun] 

Shellexecute=”SinglePDF_Binder.pdf” 

 
This will ensure that when this binder is burnt to a CD/DVD and then upon loading into a DVD drive, the correct 
document is launched, namely SinglePDF_Binder.pdf. 
 
If documents are maintained in their native format, the PDF generated and the subsequent entry written to the 
autorun.inf still follows the above logic. 
 
Regardless of checked state of Binder Options, the above logic still follows.  
 

Multiple PDF Binder – Because multiple documents are created for a Multiple PDF Binder, in default workflows, a 

document by the name of TableOfContents.pdf is created, which in turn is written to the autorun.inf. 

If the Table of Contents option is unchecked in Binder Settings, no TableOfContents.pdf is produced, therefore 

the contents of the autorun.inf has to follow different logic. 

If the table of contents checkbox is off, and a document has been marked as Cover Page, then the contents of 

the autorun.inf will read:  

 

[autorun]  

shellexecute="[CoverPageDocumentName].pdf" 

 

If the table of contents checkbox is off, and no document has been marked as Cover Page, then the contents of 

the autorun.inf will read  

 

[autorun]  

shellexecute="[DocumentName of first document in binder].pdf"    
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Header and Footer Field Codes 

Insert Field Code – Field Codes can be automatically inserted into the Header and Footer of your Binder PDF.  

Headers and Footers, including Field Codes, can be applied to the Left, Centre and Right of each Header and 

Footer by clicking on the text box beneath each to activate.  Once activated, manually enter information, or use 

the predefined Field Code dropdown list.  

o Available Field Codes: 

 <<pagenumber>> - Displays the absolute page number relative to the document; 

 <<pagenumberex>> - Displays the page number relative to the entire Binder PDF; 

 <<lastpagenumber>> - Displays the absolute last page number relative to the document; 

 <<totalpages>> - Displays the total number of pages in the Binder PDF; 

 <<batesnumber>> - Displays the Bates Number as specified in Numbering Sets; 

 <<batesnumberfirst>> - Displays the first Bates Number as specified in Numbering Sets; 

 <<batesnumberlast>> - Displays the first Bates Number as specified in Numbering Sets; 

 <<sectionnumbers>> - Displays the relative section number represented on the thumbnail; 

 Not available in pdfDocs 4.1 

 <<sectionnumberslastpage>> - Displays the last relative section number represented on the 

thumbnail; 

 Not available in pdfDocs 4.1 

 <<date>> - Displays the date on which the Binder PDF is created, applying the formats 

below; 

 <<date:d>> - Displays the day date in 1/1/2000 format; 

 <<date:dd>> - Displays the day date in 01/1/2000 format; 

 <<date:ddd>> - Displays the day date in Wed 1/1/2000 format; 

 <<date:dddd>> - Displays the day date in Wed 01/1/2000; 

 <<date:M>> - Displays the month date in 1/3/2000 format; 

 <<date:MM>> - Displays the month date in 1/03/2000 format; 

 <<date:MMM>> - Displays the month date in 1/Mar/2000 format; 

 <<date:MMMM>> - Displays the month date in 1/March/2000 format; 

 <<date:yy>> - Displays the year date in 1/1/07 format; 

 <<date:yyyy>> - Displays the year date in 1/1/2007 format; 

 <<date:hh>> - Displays the hour time in 12 format; 

 <<date:mm>> - Displays the minutes in 30 format; 
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 <<date:ss>> - Displays the seconds in 15 format; 

 <<docname>> - Displays the document name; 

 <<docaltname>> - Displays the document’s alternate name; 

 <<docparentname>> - Displays the parent document’s name; 

 <<docparentaltname>> - Displays the parent document’s alternate name; 

 <<doclastpagenumber>> - Displays the document’s last page number relative to the Binder 

PDF; 

 <<doclastpagenumberex>> - Displays the document’s last page number relative to the 

entire Binder PDF; 

 <<description>> - Displays a description as recorded in Properties; 

 Note that the ‘Description’ column in the Binder Project workspace is dynamic, in 

that entering text within the ‘Description’ column will automatically update the 

properties of the associated document. 

 <<dmdocidsource>> - Displays the document’s ID when integrated with a document 

management system; 

 <<dmlibrarysource>> - Displays the Library from which the document was sourced when 

integrated with a document management system; 

 <<dmversionsource>> - Displays the document’s version when integrated with a document 

management system; 

 <<BinderName>> - Displays the binder name given to the binder at time of Make Binder. 

 <<ProjectName>> - Displays the project name as appears on the Binder Project tab. 
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Options 

Application settings are configured through File > Options, and influence default behaviour such as how pdfDocs 

is launched, how printed documents are loaded in to pdfDocs, configuration of watchfolders and Outlook 

integration settings. 

 

General 

Default Layout and Zoom 

Options to set default view of a PDF when opened in single document mode. Organizer projects have their own 

view settings available on the View tab. 

Default layout and zoom options will influence how PDF’s are opened, pre-determined Initial View settings 

applied to a PDF will take precedence over these default layout and zoom settings. 

 

 

 

Display 

Display options to control how many unpinned recent documents and recent folders that are presented to the 

user in the backstage view. The default value at install is 7, with a maximum count of 30 for each. 

 

All open active projects will show in their own ‘Open Projects’ section. These will be applicable for Send to 

Project workflows. 
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Image Conversion Options 

Image Conversion Options manage how image documents are converted to PDF on import and print to pdfDocs. 

Word Document Conversion Options control methods for conversion to PDF from Microsoft Word. 

 

Outlook Message Conversion Options 

Outlook message files imported to an organizer project will be converted to PDF. The two methods of 

conversion will either show or not show header information on who sent the document to pdfDocs. 

 

 

Without header information. 

 

 

With header information. 

 

 

This method is also utilized through the Make Binder process in Binder Projects. Electing not to show header 

information will offer faster PDF conversion methods over showing header information. 
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Word Document Conversion Options 

By default, ‘Do not create bookmarks and hyperlinks’ is enabled, no bookmarks; hyperlinks or references are 

maintained during conversion to PDF. 

‘Create hyperlinks and bookmarks using headings’, this will ensure that the conversion to PDF of documents that 

contains headings, hyperlinks and bookmarks, will be maintained through Office to PDF conversion method. 

‘Create bookmarks and hyperlinks using custom settings’ will use pdfDocs print to PDF conversion method, and 

will allow for the customization of which headings and styles are converted to bookmarks. To customize, open 

Microsoft Word and select the Settings icon from the DocsCorp ribbon.   

Selecting the settings icon will launch the ‘pdfDocs – Word Export Settings’ window 

 

 

If you select the ‘Create Bookmarks’ option you need to set which heading styles will be converted as 

bookmarks.  

Select the ‘Bookmark styles’ tab to set required heading styles. 

Indicate which heading styles are to be converted into PDF bookmarks. You do this by placing a number next to 

the heading style. ‘1’ represents the highest level of bookmark in the PDF.  

Each number can only be used once. Placing a ‘2’ against a style indicates that style will be a sublevel of the 

heading style indicated as ‘1’. 

If Hyperlinks is checked from the Settings tab, Hyperlinks within the document will be preserved when the 

document is converted to PDF. 

Items such as Table of Contents; Cross References; Footnotes and EndNotes within the document will be 

preserved on conversion to PDF when References is checked from the Settings tab. 

Selecting one of the save options in the DocsCorp Word ribbon bar will commence the Export to PDF workflow. 

Word to PDF will evaluate your document for hyperlinks and heading styles. During this time you will see a 

progress window displayed, plus you will notice your Word document being assessed as part of this workflow. 
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Import and Open Options 

Import and Open Options influence the destination of a document sent to pdfDocs. By default, this is set to ‘Ask 

me what to do’.  

  

A document sent to pdfDocs will open in a new single instance of pdfDocs and the user will be presented with 

the backstage view from which the document can be saved or sent to an Organizer or Binder Project. 

Alternatively, selecting ‘Import into an Organizer Project’ will allow for the selection of a default project to which 

documents are sent to after selecting ‘Import into Project’ 

 

 

This will require for a previously created pdfDocs 4 Organizer Project to be selected. Create a new Organizer 

Project first from the File > New > Organizer Project menu item. This project can then be selected by browsing 

through to the *.pop file. Documents printed to pdfDocs will be loaded in to the chosen Organizer Project. The 

target project can also be set as a Binder Project. 

Selecting ‘Ask me what to do’ will present you with the Export To menu in backstage view, allowing you to select 

to which project you wish to send the document to. 

Print Options 

Print options manage how documents printed to pdfDocs are loaded. By default ‘Open in a new window’ is 

selected. Documents printed to the DocsCorp PDF Printer will open the PDF in a new single document instance 

of pdfDocs. 

Alternatively, from the drop down, an Organizer Project or a Binder Project can be selected. An Organizer 

Project or a Binder Project will need to be created prior to this selection. 

Printing to the DocsCorp PDF Printer will result in the document being converted to PDF and sent to the selected 

project. 
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Send to Project Options 

Documents can be sent to another project. Any document opened in to 

single document mode, for example double clicking on a PDF attachment in 

Outlook, will allow for the document to be sent to a project. As part of the 

send to project workflow, the source document can be closed once it has 

been sent to a project. 

These settings control the visibility and default behaviour for closing a 

document after sending to a project. 

 

Save and Export Options 

A workflow out of pdfDocs for Save As or Export, offers options to save to disk. Once the save or export 

workflow has been completed, the folder location and/or the document can be opened by selecting one or both 

of the checkboxes. 

 

Acrobat Reader 

It is suggested that pdfDocs is set as your default viewer. It is acknowledged however that your preference 

would be to keep Acrobat Reader as your default PDF viewer. pdfDocs at install will auto-detect the installation 

location of Acrobat Reader, or this can be configured manually. 

 

Language 

Controls the language in which the pdfDocs interface is displayed with.  

Languages currently available from 4.2 u1 English (US); English (UK); German and Norwegian Bokmål.  

Spanish and French are currently scheduled for a future release. 
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Binder 

Offers the choice on whether or not to show attachments in the Binder Project under their parent msg file. 

Enabling this option will bring in attachments with their parent message file when the message file is imported 

in to a Binder Project. When enabled, attachments are extracted to a maximum of two levels. 

To enable, start pdfDocs then go to:  

File > Options > Binder 

Check the option for ‘Extract Outlook .msg file attachments’ 

 

OK to commit changes. 

In Binder projects, any Outlook msg file imported will show attachments to two levels 
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Any email that has an attachment will show a sibling folder indicated by a paper clip icon, clicking on the icon will 

show the attachments associated with the parent message file. If an attachment is another msg file, any 

attachments in this second msg file will also show. 

The received or sent date associated with the msg file will show in the Received/Sent column. Clicking on this 

column header will sort by this date. 

Attachments can be removed from the parent message file, but documents cannot be added to a message file. 

This is to ensure that the content of the original message file cannot be altered through adding of documents 

that were not added to the original source email. 

Choice to convert the parent msg and/or the attachment to PDF during the Make Binder process is controlled 

through the ‘Convert to PDF’ column. Unchecking this option will leave the selected file in its native format, with 

the unconverted documents embedded in the final PDF as an attachment. 

 

Digital Signature 

These settings dictate the content and appearance of Digital Signatures applied to documents. 

A signature field can be added to a document. From the Protect ribbon select ‘Add Signature Field’ from the 

Digital Signature drop down. This is a placeholder upon which a digital signature can be applied.  

A prompt can be presented when saving a document which contains any unsigned signature fields, the prompt is 

enabled by checking the ‘Prompt to sign when unsigned signature field exists’. This checkbox can be found under 

File > Options > Digital Signature > Unsigned Document. 

 

There is a key difference for digital signature workflows when working on a PDF in single document mode, or 

when working in an organizer project. 
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If you add a digital signature field to a document in an organizer project, the application of the digital signature 

will only apply when saving the document out of the project.  

When working on a PDF in single document mode, a digital signature can be applied to a PDF immediately if 

required. Alternatively, a digital signature field can be added in preparation for signing at a later date. To sign at 

a later date, right click on the digital signature field and select ‘Sign Document’, otherwise a prompt to sign 

unsigned digital signature fields will be presented so long as the prompt to sign checkbox is checked. 

 

Integration 

For information on integration with document management systems, please refer to Integration with Document 

Management Systems on page 51. 

OCR 

OCR Provider 

Current OCR Desktop licenses provided through pdfDocs 3 will be respected when upgrading to pdfDocs 4. 

pdfDocs can be configured to run an OCR process locally through OCR Desktop, or through a server side solution 

OCR Server. Which option is available is down to licenses purchases through DocsCorp and installing the relevant 

module, by default pdfDocs 4 is shipped with OCR Desktop but it does need to be licenced.  

OCR Desktop or OCR Server provide for options to scan an image based document, creating a text layer to the 

document which will allow for searching of text across the document. OCR functions are available from the Edit 

ribbon or right clicking on a thumbnail on the Pages pane. 

There are a number of recognition templates shipped with pdfDocs, these system defined templates cannot be 

edited, but they can be copied at which point they can be edited. 

From the OCR menu, select one of the recognition templates and click on Copy. This will create a copy of the 

selected template, this copy can be renamed and opened to customize the recognition settings. 

Please refer to Appendix E - pdfDocs OCRDesktop on page 72 for further information. 
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Organizer 

Options to clear documents from a specific organizer, after close, or performing an output action from the 

organizer. Active projects will show in the drop down menu. Clear organizer options are project specific.  

Set required parameter such as ‘Only checked documents’, or delete after action such as email. Documents will 

be deleted from the project when the selected criteria is met. 

 

 

Outlook 

Options to convert Outlook attachments to PDF are managed through settings in Integration – Outlook 

General 

pdfDocs Outlook integration is an optional module that is installed by default when installing pdfDocs. After 

install the ‘Render attachments to PDF for every email’ is set to prompt by default. 

When sending emails through Microsoft Outlook, there are a number of prompts that can be shown on screen, 

by default all prompts will show. Prompts can be disabled during the Send workflow, or they can be hidden by 

selecting the corresponding checkbox under the General section. 

Internal List 

Email addresses or domains added to the internal list, and with Active selected, will bypass the convert to PDF 

workflow if the recipient appears in the Internal List. If the draft email contains one or more address or domain 

that does not appear in the Internal List, prompts to convert to PDF will be shown. 

Any recipient that is in the same organization are classed as internal, if the ‘Automatically assume recipients in 

the same organization are internal’ is checked. 
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Exception List 

Email addresses or domains added to the Exception List, and with Active selected, will bypass the convert to PDF 

workflow if the recipient appears in the Exception List. If the draft email contains one or more address or 

domain that does not appear in the Exception List, prompts to convert to PDF will be shown. 

Outlook Ribbon 

Select the checkbox for ‘Display Outlook Ribbon’ will show the ‘Convert Attachment’ icon on the Microsoft 

Outlook addin ribbon. Convert to PDF workflows can be disabled by toggling this icon on and off. 

 

 

Page Display 

Rendering 

These options control and influence how pdfDocs presents various elements within the PDF to screen. 

 Smooth Text will specify how to smooth (anti-alias) text. 

 Smooth Line Art will specify whether to use smoothing for line art, improving the definition of fine lines. 

 Smooth Images will specify whether to use smoothing for images, which may in some circumstances 

improve scanned document quality for example. 

 Enable Thin Line Heuristics, will attempt to improve line definition when drawing rectangles 

 

 

Save 

Save Projects  

Organizer Projects will be automatically saved based on the time setting. The time correlates to minutes. This 

setting does not have any bearing on Binder Projects, or PDF documents opened in single document mode. 
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Save As 

Configure your preferred location when saving a PDF to disk. 

 

Watchfolders 

Watchfolders 

Watchfolders provide for a destination on disk to which documents can be dropped and sent to from a scan 

process. 

Once documents arrive in a watchfolder, pdfDocs will detect these documents and convert to PDF, with the 

resultant document sent to a project or opened in single document mode. 

Select the watchfolder menu item from the options window, and select Create. Choose a location on disk to 

create your watchfolder, once the location has been selected, enable the watchfolder and select whether or not 

documents sent to the watchfolder will be OCR’d.  

If a watchfolder is enabled for OCR by selecting ‘Recognize Text’, the preferred ‘Recognition Template’ can be 

selected from the recognition template drop down. 

 

 

Once a watchfolder has been enabled in pdfDocs 4, pdfDocsMON.exe will start, 

this is required to monitor the contents of enabled watchfolders. This replaces 

pdfDocsMonitor which use to run continuously with installations of pdfDocs 3. 
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Technical information & troubleshooting 

System requirements 

 Recommended Client Workstation Specifications 

Processor 2GHz or faster 

Operating System Microsoft® Windows Server® 2012 R2 

Microsoft® Windows Server® 2008 R2 

Terminal Services / Citrix Metaframe on Microsoft® Windows Server® 2012 R2 or Microsoft® 

Windows Server® 2008 R2 

Microsoft® Windows® 8 and 8.1 

Microsoft® Windows® 7 

Memory 1GB or higher  ̂

Hard Disk Approximately 3Gb of available hard-disk space for installation and up to an additional 100MB of 

working space for files being converted, depending on the size of files being converted. 

Note: 2GB free space minimum on C:\ is required for installation to progress. 

Microsoft .NET Framework Microsoft .NET Framework 4.5 

Visual Studio 2010 Tools for Office Runtime VSTO 2010 Runtime 

Microsoft Office 

(Optional Integration) 

Microsoft® Office® 2013 (32-bit and 64-bit) 

Microsoft® Office® 2010 (32-bit and 64-bit) 

Microsoft Office 365 DocsCorp products will integrate successfully with Microsoft Office 365 when the product is installed 

locally. No integration is possible currently in Office Online apps or Office 365 when installed using 

Office on Demand. 

 

Email (Optional) Microsoft® Outlook 
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Supplementary software requirements 

Software Required version Internet download link 

.NET Framework 4.5 required 

Required to install pdfDocs. 

.NET Framework 4.5 - Full Redistributable  Package 

This download contains the entire .NET Framework 4.5 and is a good option for pushing out 

the installer to many machines. 

http://www.microsoft.com/en-us/download/confirmation.aspx?id=30653 

.NET Framework 4.5 - Online Installer 

This download is a bootstrapped installer for .NET Framework 4.5. It will detect what 

components are already installed, and only download what is required for your system.  

Internet connection required –  

http://www.microsoft.com/en-us/download/details.aspx?id=17851  

Visual Studio 2010 

Tools for Office 

Runtime 

VSTO 2010 Runtime 

Required to install pdfDocs 

Office integrations 

http://www.microsoft.com/en-us/download/details.aspx?id=42513  

Windows Installer 

 

5 pdfDocs 4 requires Windows Installer 5.0 or higher.  

If you require Windows Installer 5.0, the link is provided below. 

http://msdn.microsoft.com/en-us/library/windows/desktop/dd408114(v=vs.85).aspx  

File server system requirements - non-Terminal Server environment 

Under normal systems pdfDocs does not specifically use the file server as it is loaded on each individual 

workstation. (The exception is when running under Terminal Server/Citrix – see next section for information). 

Only 2 files are stored on the file server. You can use any file server that can be viewed as a network drive by 

your Windows workstation.   All versions of Microsoft®, Novell and Linux servers are supported.  The server will 

require approximately 1GB of disk space to store the pdfDocs installer and configuration files.  No software runs 

on the server, so there is no memory usage. 

File server requirements - Terminal server/Citrix environment 

pdfDocs will operate under the following server based systems: 

 Terminal Server and Citrix Metaframe 

It will not operate under Windows NT Terminal server. When installing pdfDocs under terminal server, it should 

be installed on the server when logged on as Administrator and via the Add/Remove programs option within 

Control Panel. 

For each logged on user under Terminal Server, 25 Mb of memory is required on the server for the pdfDocs print 

monitor to operate.  Each user which has the pdfDocs program window open, they will use an additional 28Mb 

of RAM on the server. 

Therefore, when calculating memory requirements for your server, you should allow 53Mb RAM per user. For 

more information on configuring pdfDocs for Terminal Server environments, consult www.docscorp.com.au. 

http://www.microsoft.com/en-us/download/confirmation.aspx?id=30653
http://www.microsoft.com/en-us/download/details.aspx?id=17851
http://www.microsoft.com/en-us/download/details.aspx?id=42513
http://msdn.microsoft.com/en-us/library/windows/desktop/dd408114(v=vs.85).aspx
http://www.docscorp.com.au/
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.NET Framework 4.5 

pdfDocs was developed in Microsoft’s Visual Studio (C#/VB .NET) and requires Microsoft .NET Framework 4.5 to 

operate. If your operating system is anything less than Windows 8, you may not have the required version of 

Microsoft .NET Framework installed.   

pdfDocs 4 will not install without Microsoft .NET Framework 4.5 on the client machine. 

Please refer to the section above in relation to the installation of Microsoft® .NET Framework 4.5. 

 

VSTO 

Visual Studio 2010 Tools for Office Runtime is required so that the pdfDocs Office integrations can be installed. If 
Office and Outlook modules are not selected as part of the installation, then this is not required. 
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Integration with Document Management Systems 

pdfDocs 4 offers integration with a number of document management systems. For additional information on 

the configuration and workflows offered for HP WorkSite and OpenText eDocs DM please refer to the relevant 

documentation available on the pdfDocs download page on the DocsCorp Resource Center. 

pdfDocs 4.1 offers integration with 

o Generic Automation 

o HP TRIM 

o HP WorkSite 9 

o Leap 

o Lawdocs 

o Lexis Nexis 

o MYOB DM Manager 

o NetDocuments 

o OpenText eDocs DM5 

o OpenText Content Server 

o Other Executable (Allowing for integration with a practice management system) 

o Other Directory 

o Prolaw 

o Reckon APS 

o Reckon Elite 

o Sage Handisoft 

o Microsoft SharePoint 

o Virtual Cabinet 

o VisualFiles 

o Worldox GX3 

 

For a full list of available integrations for all DocsCorp products, please refer to the DocsCorp Integration Matrix. 

  

http://www.docscorp.com/en/support/resource-portal/
http://www.docscorp.com/Documents/Integration%20datasheets/DocsCorp_Integration_Matrix.pdf
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Auto Detection 

At launch of pdfDocs, the following document management systems will be automatically detected 

 HP TRIM 

 HP WorkSite 

 NetDocuments 

 OpenText Content Server 

 OpenText eDocs DM 

 Prolaw 

 Visualfiles 

 Worldox GX3 

All other integrations will need to be added manually. Go to File > Options > Integration and select Add. 

To disable auto-detection, uncheck the ‘Auto detect and enable installed Document Management Systems’ 

checkbox under File > Options > Integrations. Alternatively, uncheck the Enable checkbox to temporarily disable 

the integration whilst maintaining your configured server settings. 

Multiple integrations can be added by selecting Add, adding required integration and repeating the process for 

each additional integration that’s required. 

Disabling a configured DMS will remove all Save into DMS options in pdfDocs. 

Other Executable 

You may wish to integrate with a program that is not listed as an available integration point. To do this, go to File 

> Options > Integrations and click on Add, Select ‘Other Executable’ and click on OK. 
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Other Executable will be added to the integrations window, and as a sub-menu item to Integrations. 

 

 

Select the sub-menu item ‘Other Executable’ 

 

 

Type in an Integration Name of your choosing. 

Browse through to the required executable. 

Type in any required parameters. 

Select OK to enable new integration. 

Other Executable allows for the saving of documents from pdfDocs to your designated application. It does not 

allow for the importing from your designated application in to pdfDocs. However you will still be able to print to 

pdfDocs from your application, selecting DocsCorp PDF Printer as your target printer. 
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Other Directory 

You may wish to documents from pdfDocs to a specified directory. To do this, go to File > Options > Integrations 

and click on Add, Select ‘Other Directory’ and click on OK. 

 

 

Other Directory will be added to the integrations window, and as a sub-menu item to Integrations. 
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Select the sub-menu item ‘Other Directory’ 

 

 

Type in an Integration Name of your choosing. 

Browse through to the required folder. 

Select OK to enable new integration. 

Other Directory allows for the saving of documents from pdfDocs to your designated directory, providing for the 

option to rename your document on saving from pdfDocs. 
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Appendix A - Binder Project - Table of Contents templates 

The following guide provides a quick reference to configuring your Binder Project Table of Contents, including 

data and format, as available in pdfDocs. 

Accessing your Binder Project Table of Contents template 

To access the Table of Contents template from pdfDocs, you must have an open and active Binder Project. 

Select Binder Options, and click on the [Open] button, this will open the default Binder Project Table of Contents 

(TOC) as a template document in Microsoft® Word. When opened in Word, the TOC template document will 

appear as follows 

 

 

The TOC template is made up of a number of elements and tags, which are referred to in this guide. 

 Elements are referred to as elements; 

 Tags are referred to as Field codes. 

Field codes are tags that display information about the Binder Project, and together, they present a dynamic and 

hyperlinked Table of Contents. 

Elements are denoted with angle brackets – e.g. < >. 

Field codes are denoted with double angle brackets – e.g. << >> 

An important concept to understand is that elements are containers of field codes.  Because elements are 

containers, they require opening and closing tags.  For example, the opening tag for the TOC element is 

<TableOfContents> and the closing tag is </TableOfContents>. 

The <TableOfContents> element contains its own field codes, including <<TableOfContentsName>>, but its 

primary purpose is to house all other sub-elements and their field codes. 

The <TableOfContents> element is mandatory.  Without it, the TOC will not generate correctly. 
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The default TOC template can be broken down into elements, and each element contains field codes: 

Element Field code Example 

<TableOfContents>   

 <<TableOfContentsName>> DocsCorp Binder – pdfDocs 

<Folder>   

 <<FolderName>> pdfDocs 

<Document>   

 <<DocName>> [DRAFT] v4.2_pdfDocs  – User Guide 

 <<PageNumberEx>> 1 

</Document>   

</Folder>   

</TableOfContents>   

Elements are not representations of data as such; rather they are containers for field codes.  It is the field codes 

themselves that DO represent data about your Binder Project. 

The resulting Binder Project TOC, based on the default template on page 2, is shown here. 
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Modifying the Binder Project Table of Contents template 

When the TOC template is opened in Microsoft® Word, it can be modified and saved for future use by pdfDocs 

when a Binder PDF is created. 

The TOC template can be configured to use different colors and shading, fonts, font sizes, etc.  In fact, the TOC 

template is a functional Word template, therefore offering most native Word options for formatting. 

The TOC template can also be configured to include images, such as corporate logos and branding. 

Most importantly, the TOC template can be configured to include additional elements and field codes. 

Adding elements and field codes to a Table of Contents 

A table of all available elements and field codes is shown below. 

Element Field code Description 

<TableOfContents>   

 <<TableOfContentsName>>  

 <<BinderName>> The current Binder Name entered at 

time of Make Binder 

 <<ProjectName>> The current Project Name as appears 

on the Binder Project Tab 

<Folder>   

 <<FolderName>>  

 <<FolderDescription>>  

<Document>   

GENERAL VALUES <<Description>> The current document’s description 

<<DocName>> The current document’s name 

<<DocAltName>> The current document’s alternate 

name 

<<DocParentName>> The current document’s parent’s 

name 
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Element Field code Description 

<<DocParentAltName>> The current document’s parent’s 

alternate name 

<<Date>> The current document’s date – 

always in the format 7/22/2009 

12:58:07 

<<DocDate>> *** The current document’s last saved 

date 

<<DocModifiedDate>> *** The current document’s last modified 

date 

PAGE NUMBERING <<TotalPages>> Total number of pages in the current 

document 

<<DocLastPageNumber>> Last page number of the current 

document 

<<PageNumber>> The current page number in the 

Binder 

<<LastPageNumber>> The last page number in the Binder 

<<PageNumberEx>> Displays the page number relative to 

the entire Binder PDF 

<<DocLastPageNumberEx>> Displays the document’s last page 

number relative to the entire Binder 

<<AutoNumbering>> The <<PageNumber>> or the 

<<BatesNumber>> 

<<sectionnumbers>> Not available for inclusion in TOC 

<<sectionnumberlastpages>> Not available for inclusion in TOC 

BATES NUMBERING <<BatesNumber>> The current Binder’s Bates Number 

<<BatesNumberFirst>> The current Binder’s first Bates 

Number 

<<BatesNumberLast>> The current Binder’s last Bates 

Number 
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Element Field code Description 

Thumbnail Numbering <<sectionnumbers>> The thumbnail number if pagination 

set on document (refer to page Error! 

Bookmark not defined.) 

<<sectionnumberslastpage>> The last thumbnail of the selected 

section (refer to page Error! 

Bookmark not defined.) 

DOCUMENT MANAGEMENT <<DMDocIDSource>> DMS Document ID 

<<DMLibrarySource>> DMS Library 

<<DMVersionSource>> DMS Version 

</Document>   

</Folder>   

</TableOfContents>   

*** Date and time formatting options available are listed in the Microsoft® date & time formatting rules on page 

62. 
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Editing the Style of Elements & Field Codes 

To change the style of the elements or field codes within the Table of Contents (TOC), first open the TOC. From 

the Binder Project, right click on the project tab and select Binder Options. 

Select the Open button from the Table of Contents section on the Binder Settings tab. This will launch the TOC in 

Word. 

Locate the field code that needs to be edited and select Ctrl + Shift + S keys on your keyboard, this will launch 

the Apply Styles edit window.  

From here, the option to modify the selected style will be available. 

Once the modification has been committed, continue with any further edits, save the changes and close out of 

the Word document. The changes will be visible in the next binder produced. 

 

Sample Binder Project Table of Contents 

The Binder Project TOC below was created by making a few modifications to the TOC template. 

 

These modifications have been made by editing the TOC template and adding the field code <<TotalPages>> 
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Microsoft® date & time formatting rules 

Format 

pattern  

Description  

d, %d  The day of the month. Single-digit days do not have a leading zero. The application specifies "%d" if the format pattern is 

not combined with other format patterns. 

dd  The day of the month. Single-digit days have a leading zero.  

ddd  The abbreviated name of the day of the week, as defined in AbbreviatedDayNames.  

dddd  The full name of the day of the week, as defined in DayNames.  

f, %f The fraction of a second in single-digit precision. The remaining digits are truncated. The application specifies "%f" if the 

format pattern is not combined with other format patterns. 

ff  The fraction of a second in double-digit precision. The remaining digits are truncated.  

fff  The fraction of a second in three-digit precision. The remaining digits are truncated.  

ffff  The fraction of a second in four-digit precision. The remaining digits are truncated.  

fffff  The fraction of a second in five-digit precision. The remaining digits are truncated.  

ffffff  The fraction of a second in six-digit precision. The remaining digits are truncated.  

fffffff  The fraction of a second in seven-digit precision. The remaining digits are truncated.  

F, %F Displays the most significant digit of the second’s fraction. Nothing is displayed if the digit is zero. The application specifies 

"%F" if the format pattern is not combined with other format patterns. 

FF Displays the two most significant digits of the seconds fraction. However, trailing zero’s, or two zero digits, are not 

displayed. 

FFF Displays the three most significant digits of the seconds fraction. However, trailing zero’s, or three zero digits, are not 

displayed. 

FFFF Displays the four most significant digits of the seconds fraction. However, trailing zero’s, or four zero digits, are not 

displayed. 
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FFFFF Displays the five most significant digits of the seconds fraction. However, trailing zero’s, or five zero digits, are not 

displayed. 

FFFFFF Displays the six most significant digits of the seconds fraction. However, trailing zero’s, or six zero digits, are not displayed. 

FFFFFFF Displays the seven most significant digits of the seconds fraction. However, trailing zero’s, or seven zero digits, are not 

displayed. 

gg  The period or era. This pattern is ignored if the date to be formatted does not have an associated period or era string.  

h, %h The hour in a 12-hour clock. Single-digit hours do not have a leading zero. The application specifies "%h" if the format 

pattern is not combined with other format patterns. 

hh  The hour in a 12-hour clock. Single-digit hours have a leading zero.  

H, %H The hour in a 24-hour clock. Single-digit hours do not have a leading zero. The application specifies "%H" if the format 

pattern is not combined with other format patterns. 

HH  The hour in a 24-hour clock. Single-digit hours have a leading zero.  

K  Different values of the Kind property, that is, Local, Utc, or Unspecified. 

m, %m The minute. Single-digit minutes do not have a leading zero. The application specifies "%m" if the format pattern is not 

combined with other format patterns. 

mm  The minute. Single-digit minutes have a leading zero.  

M, %M  The numeric month. Single-digit months do not have a leading zero. The application specifies "%M" if the format pattern 

is not combined with other format patterns. 

MM  The numeric month. Single-digit months have a leading zero.  

MMM  The abbreviated name of the month, as defined in AbbreviatedMonthNames.  

MMMM  The full name of the month, as defined in MonthNames.  

s, %s The second. Single-digit seconds do not have a leading zero. The application specifies "%s" if the format pattern is not 

combined with other format patterns. 

ss  The second. Single-digit seconds have a leading zero.  
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t, %t The first character in the AM/PM designator defined in AMDesignator or PMDesignator, if any. The application specifies 

"%t" if the format pattern is not combined with other format patterns. 

tt  The AM/PM designator defined in AMDesignator or PMDesignator, if any. Your application should use this format pattern 

for languages for which it is necessary to maintain the distinction between AM and PM. An example is Japanese, for which 

the AM and PM designators differ in the second character instead of the first character.  

y, %y The year without the century. If the year without the century is less than 10, the year is displayed with no leading zero. 

The application specifies "%y" if the format pattern is not combined with other format patterns. 

yy  The year without the century. If the year without the century is less than 10, the year is displayed with a leading zero.  

yyy The year in three digits. If the year is less than 100, the year is displayed with a leading zero. 

yyyy  The year in four or five digits (depending on the calendar used), including the century. Pads with leading zero’s to get four 

digits. Thai Buddhist and Korean calendars have five-digit years. Users selecting the "yyyy" pattern see all five digits 

without leading zero’s for calendars that have five digits. Exception: the Japanese and Taiwan calendars always behave as 

if "yy" is selected. 

yyyyy The year in five digits. Pads with leading zero’s to get five digits. Exception: the Japanese and Taiwan calendars always 

behave as if "yy" is selected. 

yyyyyy The year in six digits. Pads with leading zero’s to get six digits. Exception: the Japanese and Taiwan calendars always 

behave as if "yy" is selected. The pattern can be continued with a longer string of "y"s padding with more leading zeros. 

z, %z The time zone offset ("+" or "-" followed by the hour only). Single-digit hours do not have a leading zero. For example, 

Pacific Standard Time is "-8". The application specifies "%z" if the format pattern is not combined with other format 

patterns. 

zz  The time zone offset ("+" or "-" followed by the hour only). Single-digit hours have a leading zero. For example, Pacific 

Standard Time is "-08".  

zzz  The full time zone offset ("+" or "-" followed by the hour and minutes). Single-digit hours and minutes have leading zeros. 

For example, Pacific Standard Time is "-08:00".  

:  The default time separator defined in TimeSeparator.  

/  The default date separator defined in DateSeparator.  
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Appendix B - Setting up Server-based Templates 

The following guide provides a reference to configuring your Server-based project templates. 

Creating & distributing server-based project templates 

Project Templates can be created and saved to a network location.  

Once saved to a pre-determined location, this location is established as a default location through an entry in 

the user’s pdfDocsAppSettings.xml.   

The pdfDocsAppSettings.xml is located in the client machine roaming profile directory, for example 

C:\Users\User.Name\AppData\Roaming\DocsCorp\pdfDocs\Config 

Open this file in a text editor and add the following lines to the xml file, substituting Dir_Path with your required 

location. This can be a mapped drive or unc path. 

 

<OrganizerSettings version="0" enforced="true"> 

    <DefaultOrganizerPath>Dir_Path</DefaultOrganizerPath> 

    <DefaultOrganizerTemplatePath>Dir_Path</DefaultOrganizerTemplatePath> 

    <DefaultServerOrganizerTemplatePath>Dir_Path</DefaultServerOrganizerTemplatePath> 

  </OrganizerSettings> 

  <BinderSettings version="0" enforced="true"> 

    <DefaultBinderPath>Dir_Path</DefaultBinderPath> 

    <DefaultBinderTemplatePath>Dir_Path</DefaultBinderTemplatePath> 

    <DefaultServerBinderTemplatePath>Dir_Path</DefaultServerBinderTemplatePath> 

  </BinderSettings> 

 

You only need to add those lines that you wish to set a default path for.  

This method of having a central store of Organizer Templates facilitates the need for standard stationery, 

numbering sets and other user options for the user in the form of local templates or for the whole company in 

the form of server based templates. 

Server based Organizer templates can then be maintained within the one area, allowing for amendments to be 

made and applied to any new Organizers created. 

Once server based templates have been created, a user who selects to create a New Project can choose 
Organizer Project From Template, then select Server Templates.  
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Creating and saving a project as a template 

1. Open pdfDocs 
2. Go to File > New > Organizer > Organizer Template 
3. Type in a Name 
4. Select a location 
5. For local templates select the location as configured against <DefaultOrganizerTemplatePath>  in 

the pdfDocsAppSettings.xml  
6. For server templates select the location as configured against 

<DefaultServerOrganizerTemplatePath> in the pdfDocsAppSettings.xml  
7. Select Create Project 
8. A new empty project will be opened 
9. Import required documents that need to always be in the project 
10. Set output options 
11. Close the project 
12. Select Yes to prompt to save changes 

Creating a project from a Server Template 

1. Open pdfDocs 

2. Go to File > New > Organizer 

3. Select Organizer Project From Template 

4. Select Local Template and browse through to your local template directory, OR 

5. Select Server Template and select project template from drop down menu 

6. Type in a name for your new project 

7. Select a location to save your new project 

8. Select Create Project 
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Appendix C - How to create and deploy firm Stationery Sets 

The following are instructions on how to create and deploy Stationery Sets to your entire user base.  If you find 

you need assistance, please contact DocsCorp Support. 

 

Creation of Stationery Set 

1. From within pdfDocs select the HOME Ribbon and “Stationery” from the Output Options section. 

 

2. Select “Manage Stationery Sets” 

 

 

3. Click on Add and give this part a Name 

 

 

4. The “Select File” window will appear.  Browse to your PDF that is your Stationery. 

 

The Stationery file has to be a PDF 

mailto:support@docscorp.com
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5. Configure the “Apply To” section as desired 

 

 

6. Click on “Save as…” and give the set a name. 

 

 

Deployment of Stationery Set 

1. Insure pdfDocs is closed 

 

2. Browse to %appdata%\DocsCorp\pdfDocs\Config\StationerySets\User 

 

3. Copy the StationerySets.xml to [CentralConfig]\pdfDocs_Config\StationerySets\Server 

 

4. Options to deploy to all users 
a. Have each user manually open pdfDocs and select File | About | Update 

 

 

b. From the Central Config location, modify the line below in the pdfDocsAppSettings.xml file 
i. <Version version="1" enforced="false">1.0.0.0</Version> 

1. Increase the “version=” value by one.   
i.e. If it’s set to 1, modify to 2.  If it’s set to 2, modify to 3. 

ii. Users will receive the Stationery Sets file on the next 24 check in for pdfDocs. 
1. pdfDocs checks every 24 hours the Central Config location for any changes. 

c. Write a script to “push” down new file to users. 
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Appendix D – Save As .TIFF 

Options and workflows for Save As  .TIFF 

Users now have the option to save multiple documents in multiple page .TIFF formats. 

When selecting Save As, the Save As menu from in the backstage will be displayed 

1. From the File Type menu select a TIFF option 

2. Select ‘Single Paged TIFF’s’ or ‘ Multiple Paged TIFF’ 

TIFF output - Example workflows 

Each of these examples, show the results dependent upon options chosen in the backstage view. 

Test 1 – Single document with multi-pages as Multi paged TIFF 

 

 

Test 2 - Single document multi-page as Single page TIFFs 

 

 

A single TIFF generated with multiple 

pages 

A five page document is split into five 

separate TIFF files, labeled sequentially 

with document name and 

document/page count 
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Test 3 – Single document multi-pages as Multi-paged TIFF 

 

 

Test 4 – Multi documents as Single paged TIFFs 

 

 

 

  

A five page document is generated as a 

single TIFF file, containing five pages 

First document with one page, result is a 

single paged TIFF with. 

Second document with five pages, result 

is five single TIFFs, with document name 

and sequential numbers reflecting 

number of pages 
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Which choice of TIFF? – An explanation 

The different kinds of tiff outputs affect the quality of the tiffs produced. 

Different compression models decrease the file size by grouping same-colored pixels, but this, at times, may 

have an adverse effect on quality. 

There are two basic classes of compression 

 Lossy – this will average out differences with an approximate rendition of the converted image 

 Lossless – this will keep all detail of the original image upon conversion 

 

LZW (Lempel-Ziv-Welch) is the most effective when compressing solid indexed colors (graphics), but less 

effective for 24 bit continuous photo images. LZW lossless compression means there is no quality loss due to 

compression. 

G3 (Group 3) - Lossless - compression uses CCITT.4 standard, which is a line by line method of coding. 

G4 (Group 4) -  Lossless -  compression Uses CCITT.6 standard, which allows for better compression ratios by 

comparing each scanned line with the previous one 

JPG compression is lossy. JPG compression is efficient. You will lose quality with JPG compression. 

PackBits compression - Lossless - uses run-length compression, which is very effective for reducing the size of 

bitmap files which contain large areas of solid color. 

 

There are two color TIFF formats that produce uncompressed outputs:  

TIFF 12bit RGB Color (No Compression) = It is Color, with 12bit RGB output (4 bits per component)  

TIFF 24bit RGB Color (No Compression) = It is True Color, with 24bit RGB output (8 bits per component) 

 

The remaining TIFF formats all produce black-and-white output with different compression modes:  

TIFF b/w, CITTT = G3 Fax Encoding, with no EOLs (End of Line). It uses a CCITT Group 3 compression. 

TIFF b/w, Fax Group 3 = G3 Fax Encoding, with EOLs (End of Line). It uses a CCITT Group 3 compression. 

TIFF b/w, Fax Group 32-d = 2-D G3 Fax Encoding. It uses a CCITT Group 3 compression. 

TIFF b/w, Fax Group 4 = G4 Fax Encoding. It uses a CCITT Group 4 compression. 

TIFF b/w, LZW (Compression tag 5) = It uses LZW-compatible compression. 

TIFF b/w, PackBits (Compression tag 32773) = It uses PackBits compression. 
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Appendix E - pdfDocs OCRDesktop 

Overview 

The following guide provides a quick reference to configuring and using pdfDocs OCRDesktop.   

Introduction 

pdfDocs provides the ability to convert PDF documents to multiple formats regardless of whether the PDF 

document contains only graphics, a mixture of text and graphics, or text only.   There is no server software or 

server component required for this to occur – all processing of documents is performed with your pdfDocs or 

compareDocs software.  This means that you can OCR documents when you are working remote to your office 

with your laptop or have no server access.   

Using pdfDocs, you can convert PDF documents into the following output formats PDF Image with invisible text 

layer  - a text-searchable PDF; Word; Excel or PDF/A. 

What does OCR mean? 

OCR (optical character recognition) is the recognition of printed or written text characters by a computer. This 

involves photo scanning of the text character-by-character, analysis of the scanned-in image, and then 

translation of the character image into character, together with formatting information such as the font style, 

underlining and other formatting. 

In OCR processing, the scanned-in image or bitmap is analyzed for light and dark areas in order to identify each 

alphabetic letter or numeric digit. When a character is recognized, it is converted into the relevant letter or 

number.  OCR technology will also check the words found against a dictionary of words for the language that the 

document has been typed in to improve accuracy and to enable special fonts only used in certain languages to 

be recognized and differentiated from other graphics or marks on the page. 

OCR produces a high degree of accuracy on typed documents with font sizes ranging from 10 point and 

upwards.   It produces a lower degree of accuracy for documents with font sizes of 9 point or less, handwritten 

documents, or poor quality document images. 

Converting PDF document to Word, Excel or Text Format 

pdfDocs has two methods of converting PDF documents into text formats such as Microsoft® Word, Excel or 

Text format and it is important to understand the benefits of each as this can significantly improve results and 

the speed of processing. 
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PDF Documents without Text 

If your PDF document contains only graphic images, or is an image PDF that has previously been OCR’d,   then 

pdfDocs will convert the entire document to a graphic and then interpret what each character is, using Optical 

Recognition technology to create the Microsoft® Word document.    

PDF Documents containing text 

If your PDF document contains mostly text and possibly some images (such as logos, pictures, etc.), pdfDocs OCR 

will convert the document to Word format without using OCR technology – it will directly interpret the text and 

font information to create your Word document.  This will provide the best quality output. 

 

Set pdfDocs to use OCRDesktop 

pdfDocs can be configured to use either pdfDocs OCRDesktop or OCR Server as its OCR engine, and you may 

switch from one to the other on a per-user basis as required, you may wish to change this setting yourself. 

To do this, go to ‘File > Options > OCR’ and choose the radio button for OCRDesktop 

 

OCR Desktop is shipped with a number of system defined Recognition Templates, these cannot be edited but 

they can be copied at which point they can be opened; edited and renamed if required. These templates can 

either be kept locally for an individual user or deployed. 

Server v's Local Templates 

OCR Templates can either be Server based or Local. When you first install pdfDocs Desktop, the server-based 

templates will be available to each user automatically.  For information about how to deploy server based 

templates, go to the section xx page. 
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The Publishing templates window shows all server and local templates.     The columns with checks in them (PDF, 

PDF/A, Word, Excel, Text) indicate which output document formats the template may be used for.  

 

 

Server Templates 

Server templates are templates that are stored on your server and are shared by all users.  In the Publishing 

Templates window, these will appear grayed out and will also say ‘Read-only’ at the end of their name. They 

cannot be modified by a local user.  These will either be the original templates created by DocsCorp, or your own 

local templates that have been converted to Server templates.  Each user has their own local copy of the server 

templates (so that mobile users can continue to access them), but on a regular basis these will be updated 

automatically by pdfDocs from the location where the pdfDocs installer was originally run on the server or 

network location (for example “…\config\recognition templates\server”), with each template being a separate 

.XML file. 

Local Templates 

Local templates are templates created by a user by adding a new template or copying an existing template.   

 The local template can then be configured to either leave each setting as defined in the system defaults for OCR 

Desktop, or override to suit user requirements.    
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Creating Local Templates 

Copy 

To create a local template, click on the Server template closest matching your requirements and click on the 

‘Copy’ button.  You may then rename the newly created template by either clicking on the ‘Rename’ button or 

by just double-clicking on the name of the template. 

 

 

Add 

Selecting the Add button is different to a Copy action, in that the template generated through Add, creates a 

local template based on the OCR Desktop system defaults. In this case, initially all settings are set as ‘Default’ 

(setting is managed by pdfDocs), but can be manually changed by the user in the template to force a particular 

action regardless of the system defaults. 
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Configuring Local Templates 

To configure a Local template, select the template in the list and click on the Open button.   Note that if you 

open a Server based template, you will be able to see all the settings, but not modify any – all options will be 

grayed out.   

To find out more about each individual setting, just hold your mouse over the checkbox or setting and a balloon 

help window will describe the option.  This guide does not repeat all the information contained in these balloon 

help messages. 

 

 

There are four separate tabs containing output settings for OCR Desktop.  The Legend at the bottom is 

important.    

 A shaded text box means that this setting is managed by OCR Desktop 

and is based on what the setting is for underlying OCR Desktop system 

defaults.  It is generally recommended that you leave any settings untouched unless you really need to change 

them to something of your choice – this choice then overrides whatever was set in the system defaults. 

 A checked option means that this setting is switched on regardless of the setting in 

the system defaults. 

 

 An unchecked option means that this setting is switched off regardless of the 

setting in the system defaults. 
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PDF Options  

These options control the creation of 

PDF or PDF/A documents relating to 

image resolution and compression of 

the created PDF document once the 

OCR recognition process has 

completed (as defined on the 

Language and Recognition Tabs).  

These are document output settings. 

To allow this template to be used 

when creating PDF or PDF/A 

documents, select the ‘Enable PDF’ or 

‘Enable PDF/A’ checkboxes.   For more 

information on exactly what each setting means, hold your mouse pointer over the description field for a 

balloon help field to display.  

 

 

Word/Excel/Text Options 

This tab defines output options when 

creating Word, Excel or Text 

documents once the OCR Recognition 

process has completed (as defined on 

the Language and Recognition Tabs).  

Use the ‘Enable Word’, ‘Enable Excel’ 

and ‘Enable Text’ checkboxes to allow 

this template to support output in 

these document formats. For more 

information on exactly what each 

setting means, hold your mouse 

pointer over the description field for a 

balloon help field to display.  
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Languages 

This tab defines what languages the OCR process will look for in the document.  These settings are only used if 

you use the ‘Perform OCR’ checkbox when publishing to Word,  Excel and Text,   and are always used when 

OCR’ing to PDF. 

 

 

You should check (select) the languages in this list that you expect to see in your documents.  You will get the 

best results if you select as few languages as possible.  This does not mean that the occasional word in another 

language will not be recognized correctly – this will still occur when required.  However, the OCR process will 

attempt to guess between random imperfections on the page to determine if they are a valid character in your 

selected language(s) or really are just marks and unreadable areas on the page and so should be ignored. 

Ideally, you should create a template for each language document you are OCR’ing for optimum results. 
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Recognition Options 

The Recognition options tab controls how the source PDF document is to be interpreted, regardless of the 

output format of the document.  

 

 

Here you can adjust the recognition methods to suit the source of your documents or the types of documents 

you are OCR’ing.  For example, you may have different settings for OCR’ing Faxes than documents coming from 

your scanner.  For example, you can switch on ‘Skew’ settings here to automatically adjust documents that have 

been scanned on an angle.   For more information on exactly what each setting means, hold your mouse pointer 

over the description field for a balloon help field to display. 

 

Recognition Options – Blank Page Handling 

The ability to split pages through the detection of blank page separators can be enabled as part of an OCR 

Template. 

By default, Blank Page Handling is disabled for all current OCR Templates. 

To enable, you will need to copy a default template and create a local template. 

Once you have created the local template copy, open the template and select the Recognition Options tab, on 

which you will be able to locate the Blank Page Handling options.  
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By default, these settings are set to Default, the default action being disabled. 

Enabling these settings is only applicable for documents that are passed through 

a WatchFolder and when the target location is an Organizer Project.  

 

Blank Page 
Handling 

Values Behavior 

Separate  Default 

 Disabled 

 Enable 

 Enabled if First 
Page Blank 

Default 

 The document will not be split.  The OCR’d document will 
have the same number of pages as the original document. 

 
Disabled 

 The document will not be split.  The OCR’d document will 
have the same number of pages as the original document. 

 
Enable 

 The document will be split for each blank page found. 

 The blank page will prefix the next output document. 

 Single output document will have a suffix of “_OCR. 

 Multiple output documents will have a suffix of “_OCR_n”, 
where n is an integer starting with 1. 

 
Enabled if first page blank 

 If first page of the original document is blank, follow 
enabled requirements 

 If first page of the original document is not blank, follow the 
disabled requirements 

Behavior  Default 

 Keep 

 Discard 

This option will only be applicable if: 
Blank Page Handling Separate = Enabled 
OR 
Blank Page Handling Separate = Enabled if first page blank 
 
Default 

 The document will not be split.  The OCR’d document will 
have the same number of pages as the original document. 

 
Keep 

 All blank pages will be kept 

 The total pages of all the output document(s) will equal the 
number of pages of the original document(s) 

 
Discard 

 All blank pages will be deleted 

 The total pages of all the output document(s) will be 
reduced by the number of blank pages 
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Server and Local Template Deployment 

Once you have created a ‘Local’ Template it is possible to deploy this to all users via the server installation 

directory of pdfDocs Desktop.   

To do this, follow these steps: 

1. Create the local OCR template on one computer in your office. 

2. Look for an xml file of that same name on your computer.  E.g.:   a Template called ‘Word Spanish’ will 

be called ‘WordSpanish.xml’ and will be contained with your other pdfDocs temporary files.  Typically 

this is found in “C:\Program Files\pdfDocs\users\yourname\config\RecognitionTemplates\Local” or will 

be where ever you have configured your installation of pdfDocs Desktop to store its temporary files. 

3. Copy that file into the directory on your server where your server.ini file is located.  You can find this 

location by going into pdfDocs - > Help menu - > About and viewing the server.ini location. Copy the xml 

template into the folder “...\config\RecognitionTemplates\Server” 

Over the next 24 hours, each pdfDocs Desktop client will be updated with this new template when pdfDocs 

Desktop is launched, or by click on the ‘’Load Defaults’ button under pdfDocs Desktop - > Help menu - > About. 

OCR Documents from the Organizer 

Documents or pages can be OCR’d into a variety of output formats. 

This can be achieved using a number of different options 

 Select OCR from the Edit ribbon, this will OCR the pages in place and add a text layer 

 Right click on a page or document and select Recognize Text, this will OCR in place the selection and add 

a text layer to the page or document 

 

Convert to anther file type 

To convert a document or page to another file type, either right click on a document or page, and select Export. 

Choose the desired file type of Word; Excel; PDF; PDF/A; Text or Image. 

You will then be taken to the Export menu in the backstage view. 
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Appendix F – Supported File Types   

The following file types are supported through Drag n Drop and Import workflows.  

File extension Description 

.bmp Bitmap 

.doc(x) .docm .dot .dotm Microsoft Word Document 

.eps Encapsulated Postscript 

.gif CompuServe Graphic Interchange Format 

.ico Icon 

.jpg .jpeg .jpe Joint Photographic Experts Group 

.msg Microsoft Outlook Message 

.pdf Portable Document Format 

.png Portable Network Graphics 

.ppt(x) .pptm .pot(x) 

.potm 

Microsoft PowerPoint 

.ps Postscript File 

.psd Adobe Photoshop Document 

.pub Microsoft Publisher 

.rtf Rich Test File 

.tif .tiff Tagged Image File Format 

.txt Text File 

.xls(x) .xlsm .xlst .xltm 

.xlsb  

Microsoft Excel Document 
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Help 

Select the question mark from the task bar to access help options 

 

License Information 

Company’s license information, including Licensee, License Type and Licensed Users. 

Selecting ‘Set License’ will allow for the entry of new or updated license information for pdfDocs and/or E-

Learning by Capensys modules. 

 

The E-Learning by Capensys modules are additional modules which can be purchased through DocsCorp. For 

further information please visit http://www.docscorp.com/en/support/capensys/ . 

http://www.docscorp.com/en/support/capensys/
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File Information 

Displays the program location, central config deployment directory and log file location. 

Get Help 

Getting Started & Advanced User Guides 

To access the latest user guides, you will need an internet connection. 

We are committed to helping our customers get the most out of their investment in our software. In addition to 
our reliable products, you can count on our dedicated team of experienced support professionals to provide 
fast, dependable service for your organization. 

E-Learning System 

Selecting this option will launch Capensys E-Learning System (if licensed). 

 

Double clicking or selecting a module and clicking on Open will launch the tutorial.  

Log a Support Call 

Selecting Select ‘Log a Support Call’ to be directed to our DocsCorp support page. Our support teams are located 

across three continents providing 24/5 support levels. 
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Log Management 

Open Log Folder  

Will take you to the roaming folder location on disk to which our log files are written. These files record events 

such as startup times; time to render documents to pdfDocs; general information logging for pdfDocs and any 

errors. The key log files are:  

C:\Users\<username>\AppData\Roaming\DocsCorp\pdfDocs\Logs\pdfDocs.log 

 Records information such as startup times and time to render documents to PDF.  

 It is a rolling file, reaching a maximum file size of 0.5MB. 

 

C:\Users\<username>\AppData\Local\DocsCorp\pdfDocs\Logs\pdfDocs.log 

 Only enabled when ‘Enable Debug Log’ is selected, and records debug information.  

 It has 10 rolling files, each reaching a maximum file size of 5MB.  

 Enabled through the option ‘Enable Debug Log’ 

Zip and Send Logs 

These logs can be conveniently zipped and emailed to us by selecting ‘Zip and Send Logs’, please send the email 
to support@doscorp.com stating (where applicable) the following information:  

 Company 

 Country 

 Your name 

 Phone number 

 Document Management System 

 Operating System 

 Office Version 

 Nature of issue 

 How many people the issue is impacting 

Enable Debug Log 

Refer to ‘Open Log Folder’ section. 

Settings 

Selecting Update will check for a more current version of the application in the installer directory and prompt to 
upgrade if a more recent version of the application has been copied to the install directory. 

Notices 

Access to the end user license agreement and legal notices and credits.

mailto:support@doscorp.com


 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Copyright © DocsCorp Group Pty Ltd 2003-2015 – All rights reserved. 

 

pdfDocs is a trademark of DocsCorp Group Pty Ltd. 

 

This program is licensed to be installed on the number of workstations shown.  pdfDocs cannot be installed 

simultaneously on any more workstations than that specified, regardless of the location of those workstations.  

Each name user under Windows Terminal Services, or similar technology which has pdfDocs available, is deemed 

a 'workstation' according to this license. 

 

pdfDocs is protected by copyright law and international treaties.  Unauthorized reproduction or distribution of 

this program, or any portion of it, may result in severe civil and criminal penalties, and offenders will be 

prosecuted to the maximum extent possible under law. 
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